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COPYRIGHT  

COPYRIGHT © 1991 - 2017 San Diego Instruments.  All rights reserved. No part of this 

publication may be reproduced, transmitted, transcribed, stored in a retrieval system, or 

translated into any language or computer language, in any form or by any means, electronic, 

mechanical, magnetic, optical, chemical, manual or otherwise, without the prior written 

permission of San Diego Instruments 9155 Brown Deer Road, Suite 8, San Diego, CA 92121-

3248.  

 

DISCLAIMER  

San Diego Instruments makes no representations or warranties with respect to the equipment 

described herein and specifically disclaims any implied warranties of merchantability or fitness 

for any particular purpose. The equipment described in this manual is designed for research 

and educational applications and is not intended for the diagnosis, alleviation, treatment, 

monitoring or prevention of disease, injury or handicap. The equipment is intended for 

operation by professional level persons only and San Diego Instruments disclaims any liability 

or responsibility for the use or handling of the system or any liability for consequential, 

special, indirect or incidental damages including loss or contamination of data, resulting there 

from. San Diego Instruments reserves the right to revise and/or modify this publication and 

the software described without obligation to notify any person of such revisions or changes. 

This is the only agreement between you and San Diego Instruments, and it cannot and shall 

not be modified by purchase orders, advertising or other representations of anyone, unless a 

written amendment has been signed by one of our company officers. This Agreement shall be 

governed by California law, and is deemed entered at San Diego, San Diego County, California 

by both parties.  
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Chapter 1: Product Overview 
 
Measuring Startle Response, Habituation and Prepulse 
Inhibition 
Startle measures are used to study a wide range of phenomena including drug toxicity, auditory system 
physiology, neurodevelopment and behavioral genetics.  Rodent studies are the most convenient and 
efficient for studying drug effects on or assessing the neurobiological mechanisms of startle plasticity. 
 
The startle response is comprised of a constellation of reflexes elicited by sudden, relatively intense 
stimuli. It offers many advantages as a behavioral measure of central nervous system activity and can be 
measured in numerous species, including humans, when elicited by acoustic (noise bursts), electrical 
(cutaneous), tactile (air puff), or visual (light flash) stimuli. 
 
 

Habituation 
Defined as the exponential decrement in response when an initially novel stimulus is presented 
repeatedly at speeds too slow to produce sensory adaptation or receptor fatigue.¹ 
This effect is called ‘habituation’ and is evidence of an animal’s “learning not to respond”.  
 

Prepulse Inhibition 
Prepulse inhibition is the normal suppression of the startle reflex when the intense startling stimulus is 
preceded 30 to 500 msec earlier by a barely detectable prestimulus¹.  Such prepulses reduce the 
magnitude of the startle response. This phenomenon is referred to as prepulse inhibition or PPI. Cross 
modal PPI can also be used where a visual or tactile prepulse is used to affect the animal’s auditory 
startle response or an auditory prepulse is used to inhibit a tactile startle response. 
 

Potentiated Startle 
Startle amplitudes can also be increased by presenting the eliciting stimulus in the presence of a ‘cue’ 
(for example, a light) that has been previously paired with a foot shock. This procedure is referred to as 
‘potentiated startle’. This procedural enhancement only occurs after the conditioning of the animal with 
repeated light-shock pairings. 
 
Although startle can be measured electromyographically, as typically done in humans, startle in 
laboratory animals is usually measured by recording whole body flinch. The startle reflex is time-locked 
and occurs within a short latency following the eliciting stimulus. Recordings of whole-body startle are 
usually taken for about 200 miliseconds (msec) after presentation of the eliciting stimulus. 
 
Excerpts taken from Measurement of Startle Response, Prepulse Inhibition and Habituation by 
Mark Geyer and Neal Swerdflow, Current Protocols in Neuroscience (1998)8.7.1-8.7.15 
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The SR-LAB System 
 
The SR-LAB system is an automated system for measuring startle responses of small animals. It can 
accommodate up to 16 ventilated chambers, each containing a cylindrical animal enclosure mounted on 
a Plexiglas base. A speaker, mounted 24 cm above the animal, provides background noise, pre-pulse 
stimuli and startle stimuli, all controlled by the SR-LAB software. Startle responses are transuded by a 
piezoelectric accelerometer mounted below the cylinder, rectified, digitized and recorded as data points 
on a computer. The user sets the number of data points to be recorded and the frequency of recording. 
Generally, the frequency used is 1000 hertz (Hz) and the number of data points recorded is 65msec in 
mice, rats or humans 250 millisecond onset of the stimulus. 
 
The animal is placed in a startle enclosure and its movements are recorded by the piezoelectric sensor 
hermetically sealed to the underside of the animal enclosure. The animal’s movements create an 
electrical current in the sensor. These currents are then amplified by a circuit in the SR-LAB equipment 
bay and are sent through the connection chassis to an A-D converter card in the controller. 
Acoustic, electrical, tactile and visual stimuli may be administered, alone or in combination. The SR-LAB 
software controls the administration of the stimuli and records the animal responses automatically, no 
programming is necessary. A ‘snapshot’ of the subject’s movements following the startle-eliciting 
stimulus is taken and recorded.  Voluntary movements that are unrelated to the startle reflex are 
eliminated from the data files. 
 
The SR-LAB software displays the selected subject's responses on screen immediately following each 
trial. The recording of the reflex results in a waveform that represents the pressure the animal’s jump 
places on the piezoelectric sensor. Typically, when reducing and reporting results of the startle trial, the 
peak of the response, the latency to peak and the average amplitude of the waveform are used. The SR-
LAB software captures a complete waveform and provides a method for the researcher to examine the 
accuracy of the summary point calculations. All the raw data from the experiment are captured and 
combined into one database file for further analysis.  The SR-LAB software permits programming of all 
functions needed for startle response testing without the need to know a programming language. This is 
accomplished by allowing the user to select from a list of alternative menus presented in a logical, 
intuitive manner. The program will provide prompts when information is needed from the user, such as 
file names or values. Thus, highly complex test routines may be designed and executed merely by 
selecting from the options that the SR-LAB software presents. 
 
The SR-LAB system is designed to take advantage of the Microsoft Windows operating system and its 
many features. Users who are comfortable working in the Windows environment will notice an 
immediate familiarity with the SR-LAB program. 

 

Startle Stimulus Presentations 
 
The startle stimulus must be both intense and sudden. In mammals, auditory and air puff stimuli are 
effective in eliciting startle. Light flashes are found to be effective with highly visual animals like birds.  
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Noises that gradually increase to high levels of volume will not induce startle. Only stimuli with very 
rapid rise times will elicit the reflex. The basic SR-LAB acoustic stimulus is a white noise with an intensity 
of up to 120 dB and with a rise time of 2 milliseconds (msec). Noises are generated by circuits contained 
in the equipment bay and are delivered with an amplitude and duration set by the researcher in the SR-
LAB software “Trial” definition routines. 
 

White Noise Stimulus - Levels of white noise acoustic signals are entered into the SR-LAB 

software “Trial Definition” menu. These numeric values are converted to output voltages by the data 
acquisition board (or card). Voltage-controlled amplifiers and speakers in each chamber’s equipment 
bay deliver the sound to the animal. 

 

Tactile Stimulus - Tactile stimuli are air puffs controlled by commands in the SR-LAB Trial 

Definition menu. The commands are converted to digital output signals from the data acquisition board. 
These signals open and close a gas solenoid connected to a source of compressed air. Copper tubes 
deliver the air puffs through an opening in the center of the animal enclosure – directed at the center of 
the animal’s back. Tactile stimuli have shown to be particularly useful in startle testing of mice. 
 

 
SR-LAB Components 
The SR-LAB system is composed of three major units: the Control Unit, the Startle Chamber/Isolation 
Cabinet, and the Animal Enclosure. 

 

SR-LAB Control Unit 
The SR-LAB Control Unit provides the connection for up to 16 startle chambers. These connectors are 
arranged as follows: 
 

Front Panel - on the front panel of the Control Unit there are 16 BNC connections each of which is a 

single chamber input connection.  There are also two LEDs indicating USB and power status. 
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Rear Panel – on the rear panel of the Control Unit is a USB connection and a 12 VDC output 

connecter. There are also four connection types for each chamber including SHOCK TRIGGER First 
chamber and Last Chamber, AC RELAY First Chamber and Last Chamber, ANALOG First Chamber and Last 
Chamber and SHOCK LEVEL First Chamber and Last Chamber.  There are an additional two DIGITAL 
output BNC connectors and a FUSE to electrically protect the SRLAB Controller. 

 

 

Startle Chamber/Isolation Cabinet 
 
The startle chamber/isolation cabinet is designed to provide sound attenuation and visual isolation of 
the test subject. The sound attenuation (40 dB at 1 meter) restricts the high levels of sound stimuli used 
in startle testing and isolates the test animal from outside sounds including interfering high frequency 
vocalizations that might come from other animals being tested.  Each chamber includes light and fan 
controls. 

 
Each cabinet is equipped with an internal light, fan, and viewing lenses. The cabinet contains a complete 
sound generation system to produce white noise stimuli up to 120 dB (the normal setting is 70 dB). 
Duration and volume of the sound are software-controlled. Separately adjustable background noise 
level and an Accessory Relay (ACC) for optional stimuli (e.g. lights, air puff, etc.) are also included with 
each station. 

 

“ABS”- The ABS isolation cabinet is constructed of ABS hair cell panels. The effects of extraneous noise 

and vibrations are minimized by the use of foam filled walls. Internal surfaces are smooth, scratch 
resistant, and easy to clean. Each cabinet measures 13 X 13 X 19 inches and weighs approximately 22 
lbs. 
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Chamber Controls Function 

Aux Power 

Connector supplies the +12V DC power for the shock in the 

potentiated Startle kit.  Note:  This power supply is 

interlocked to the cabinet door so the door must be closed for 

power to be applied (export models only). 

AC Relay (manual) 
Push button applies power at the CUE OUT connector to 

manually test the optional Cue Light or Tactile kits. 

 Fan  Switch turns the fan on and off. 

Light/Cue 
In the UP position, this switch directs power to the cabinet’s 

interior light.  In the center position, the light is OFF.  In the 

Rear of SR-LAB 

Front of SR-LAB 
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DOWN position, the switch follows the instructions for the 

Cue light as directed by the SR-LAB software. 

Audio Adjust 

This dial can be turned to adjust the white noise level.  

Typically there is no need to adjust the factory setting but if 

necessary the noise level can be adjusted until the sound 

pressure level meter reflects the desired noise level.   

Audio Analog In/Out 

These connections control the audio signal produced by the 

electronics contained in the chamber.  For multiple  

SR-LAB chambers, the connection becomes a “daisy chain” 

from the Control Unit to the first chamber, the first chamber 

to the second chamber, etc. and finally from the last chamber 

back to the Control Unit.  

AC Relay In 

The AC Relay connector links the SR-LAB Control Unit to 

the various SR-LAB chambers to enable the SR-LAB 

software to manage the administration of various types of 

stimuli including light and air.  For multiple chambers, 

perform the same process of daisy chaining one chamber to 

the next as described above in the Audio Analog section. 

Response Out 

Permits each SR-LAB chamber in the configuration to be 

connected to the SR-LAB Control Unit enabling all 

chambers to be controlled by the SR-Lab software.  Each 

chamber is directly connected to the SR-LAB Control Unit 

with a cable. 

Cue Out 

The Cue Out is a 12 VDC outlet that drives a variety of 

optional stimuli kits.  In order to control the Cue Out, the AC 

Relay connections between the SR-LAB Control Unit and 

each SR-LAB chamber must be established.  With this 

connection, the SR-LAB software manages the 

administration of various types of stimuli.  Note:  The Cue 

Out synchronizes the current among the SR-LAB stations.  

The 12 V are independently provided. 

Response Adjust Adjusts the amplification level of the Response Signal 

Power In 

This slot is where the external power supply to the SR-LAB 

chamber connects.  CAUTION: Units built prior to July 

2005 were designed to use a 15 VDC power supply.  Units 

built after July 2005 are designed to use a 12 VDC power 

supply and should never be connected to any unit marked as 

a 15 VDC unit.  The power supplies look similar – please 
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read the labels to check the ratings before plugging them into 

an SR-LAB chamber. 
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The SR-LAB Animal Enclosure 
 
The SR-LAB animal enclosure is designed to locate the test animal so that the body of the animal is 
centered over the motion sensor. It is important that the animal not be subjected to restraint. The 
appropriate sized animal enclosure permits the animal to turn around in the enclosure. Five standard 
sizes of enclosures are available with the SR-LAB. These interchangeable enclosures make it possible to 
change quickly from small cylinders suitable for mice to larger cylinders for rats. The mice-sized animal 
enclosures (small and small/medium) are equipped with an ultra-sensor base plate. Snap in doors adjust 
to the length of the subject being tested. 
 

Enclosure Length Interior  

Diameter 

Approximate  

Weight 

Small (with Ultra Sensor) 3.5” 1.1” Up to ~25 g 

Small/Medium (with Ultra 

Sensor) 
5” 1.5” 

Up to ~50 g 

Medium 6” 2.25” Up to ~150 g 

Large 8” 3.5” Up to ~450 g 

Extra Large 10” 5” Up to ~800 g 

 
The animal enclosure sits on a support base and is plugged into the amplification circuits in the SR-LAB 
chamber’s equipment bay.  The enclosure can be connected to a calibrator for periodically checking the 
accuracy of the response measurement. 
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Chapter 2: Installation 
 
Getting Started  
Safety Instructions for Using the SR-LAB 
 
Immediately report any shipping damage to the shipper. 
 
Observe the orientation and pin configuration of all connectors. Connections should not require force.  
 
DO check to make sure solid electrical connections are established. 
 
DO NOT turn on the SR-LAB chambers without FIRST turning on the computer and configuring the SR-
LAB software. Failure to adopt this practice may cause the cabinet sound level to go to its maximum and 
destroy the speaker. The speaker and sound generation circuitry is designed to operate at maximum 
output for only short periods of time. Longer periods at maximum output can cause degeneration in the 
sound system. 
 
DO NOT Make connections (or disconnect cables, etc.) without turning off power to the system. 
 
DO NOT Replace fuses with fuses that are rated higher than the rated value. 

 

Gather Your SR-LAB System Components 
 
Carefully remove the SR-LAB components from the shipping cartons and gently remove packing 
materials from the startle chamber and animal enclosure taking particular care when removing the 
packing material surrounding the animal enclosures.  Make sure you have the following components 
before getting started with the installation of the SR-LAB software and hardware. 
 

Hardware 
1) SR-LAB Chamber/Isolation Chamber 
2) Animal Enclosure with Door and Base 
3) SR-LAB Control Unit with Cable (to connect the Control Unit to the PC or Laptop) 
4) Two Coaxial Cables per SR-LAB chamber plus one extra coaxial cable (if more than 1 SR-LAB is 

ordered) to complete the Analog connection  

 
 

5) Two thin black cables for AC RELAY 

AC relay cable Coaxial cable 
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6) 12 Volt Power Supply and Power Cord for control box (small) 
7) 12 Volt Power Supply and Power Cord for SR-LAB box (red tape labeled) 
8) Standardization Unit with Power Supply and Power Cord (optional) 

 

Connecting the Hardware Components 
1. Connect the 12 Volt power supply (red tape labeled) to the SR-LAB box. 

2. Connect the 12 Volt power supply (small) to the Control box. 

3. Connect the USB cable to the Control box and the computer. 

4. Connect the thin cable to AC RELAY First Chamber on the control box then connect 

other end to AC RELAY IN on the SR-LAB.  

5. Connect a coaxial cable (thick cable) to the ANALOG first chamber on the back of the 

control box then connect other end to the AUDIO ANALOG IN on the SR-LAB. 

 

***if connecting two or more SR-LAB box The AC RELAY OUT will connect to the next SR-

LAB AC RELAY IN on the next SR-LAB box.  From there repeat step 4 until all boxes are 

connected creating a daisy chain effect.  Once all connected, connect the last SR-LAB AC 

RELAY OUT back to the control box.  Do the same for the Analog cables. 

 

6. Take the last coaxial cable and connect it to the RESPONSE OUT on the SR-LAB and the 

other end to the front of the Control Box to CHANNEL INPUT 1. If connecting more 

than 1 SR-LAB continue to connect the RESPONSE OUT to the next channel number on 

the front of the control box.  Keep in order and do not skip numbers. 

7. Take the animal enclosure and place inside the SR-LAB chamber and plug into the 

upper left corner ceiling.   
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Installing the SR-LAB Software  
USB Stick 
Leave the control box disconnected from the computer during the software installation. 
 
 
 

1. Insert SDI USB installer stick in a USB port 
2. View files and click on SDIInstaller.exe 
3. All install files will be copied to the hard drive in this folder:  

C:\San Diego Instruments\6300-0000_SRLAB_InstallFiles 
4. The SRLABUSBInstaller will run automatically going through up to three installations: 

SR-LAB Software 
MS Access Data Base Engine 
MCC Drivers 
Follow the prompts on the screen 

5. When the SRLABUSBInstaller completes, restart the computer and upon completion of 
the restart plug the USB cable from the control box into the computer.  
All cords should be connected, plugged in and turned on at this time. 

 
 
 
 
 
.   

NOTE: If you are installing the SR-LAB Software on a Microsoft Windows 7 computer, you will need to Turn 

OFF all User Account Controls and install and run the SR-LAB as an Administrator on the computer. 
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6. Run from the start button Start➔All Programs➔InstaCal➔ let the system recognize the 

board.  It will go through some questions that you answer yes to so it can recognize the 

board. 

 

 
 

7. Once the board is recognized Board#0 - USB-2527 (serial#.........).   Write down this serial 

number and keep it in a safe place. 

 

8. Double click on it to bring up the Board Configuration dialog: 

a. Change No. of Channels: to 16 Single Ended (This will allow 16 input channels to be 

used). Do this step regardless of how many SR-LABs you have. 

b. Change Settling Time: 10us (this will prevent ADC input channel crosstalk) Click OK then 

close the window. 
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(For SR-LAB Part 11 software skip to #10) 

9.  Start the SR-LAB software and enter the release code to combine the software with SR-

LAB controller.  From the main menu select Run➔Release Code…  This will open a dialog 

to enter the supplied release code. 

***The release code is listed on the Left Inside cover of the Manual and on the 

bottom and top of the control box*** 

Click apply; then close, to close the window. 
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10. Start the SR-LAB software Part 11 and click Run 

 
 
Choose User Login 

 
Enter User: Admin and Password: admin(Both are case sensitive) 
These are default Administrator User and Password, exposed to all SR-LAB Part 11 Users, 
see #12 below for replacing the defaults 
 

11. Click Run on the main menu and click Release Code 

 

 

 

 

 

 

 

 

 

 

 

 

 

The Release Code dialog box appears, enter the release code and click Apply. 
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***The release code is listed on the Left Inside cover of the binder and on the bottom 

and top of the control box*** 

12. At this point refer to the User Manual Appendix F: FDA Part 11 Compliance to setup Users, 

Passwords and Permission levels.  Do not delete the default Administrator User and 

Password until you have set up a unique Administrator. 

 

Reinstallation 

 
As part of step 3 above, this icon will be placed on the Desktop.  Clicking it will start the 
SRLABUSBInstaller Reinstallation 
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Chapter 3: SR-LAB Software 
How the software works 

 
The SR-LAB takes user defined trial and session definitions to create test sessions within a study database.  

SR-LAB uses Microsoft Access database to collect data and session reports can be exported to Microsoft 

Excel or a tab separated text file.  Also, the raw data collected at session test can also be exported to an 

Excel or, alternately, to a “tab” separated text file which can then be imported by a variety of statistical 

software packages. 

 

Before getting started it is crucial you run the diagnostic program that will test components, aid in 

calibration and act as an aid when troubleshooting any hardware issues. 

 

SR-LAB software also provides a post session data analysis program that will analyze the raw data given 

user defined parameters.  

 

SR-LAB Main Screen Overview 
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The SR-LAB main screen is a single screen configuration that allows access to define, diagnose, run tests 

and view reports.  All selections are from the Main Screen Menu and when a database has been opened 

the title of the database file will appear on the window.  

  

File ➔ Menu Item Function 

 Define Default Data Directory… 

Allows the user to define the default directory to store the 

study database files.  When installed the default data 

directory is:  

C:\Users\Public\San Diego Instruments\Data 

Create New Study Database… 
Creates a new study database.  The created database will 

reside in the default data directory. 

Open Study Database… 

Opens a study database.  Any study database can be selected 

but if the selected database does not reside in the current 

default data directory it will be saved in the directory from 

which it was selected. 

Definitions… 

Selection to define unique trials and sessions.  This data is 

stored in a separate database.  There are also selections to 

backup and restore definitions.  This feature allows for 

different researchers to each maintain their own definitions 

as well as backing up definitions before reinstalling updated 

versions of SR-LAB software.  The last selection is “Convert 

Definitions…”. This allows users to convert the older *.TAS 

and *.SAS definition files to the newer format.  Please see 

Appendix G for information. 

Create Sessions… 

Selection to allow user to define sessions for test.  This 

selection is only available when a study database has been 

opened.   

Create Subjects… 

Selection to bring up window that will allow subjects to be 

assigned to sessions and chambers. This selection is only 

available when a study database has been opened. 

Save As… 

Allows study database to be saved to a different filename. 

This selection is only available when a study database has 

been opened. 

Save 
Save currently opened database. This selection is only 

available when a study database has been opened. 

Exit Closes SR-LAB program 
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Run ➔ Menu Item Function 

 Diagnostics… 

This selection brings up a diagnostic window to verify and 

calibrate the SR-LAB.  It is not necessary to Open a study 

database to run the diagnostics.  However, some 

diagnostic/calibrations functions require a separate 

diagnostic database to be loaded in the Diagnostics program. 

Session… Opens window to run previously created sessions 

Report… 
Opens a report window that displays the results of completed 

sessions 
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The SR-LAB Diagnostics Screen 
 
The first time the SR-LAB system is used and before beginning a session run, ensure that the connections 
from the SR-LAB chambers and their animal enclosures are working properly.  From the Main Screen 
Menu select Run➔Diagnostics and the screen below appears.  Continue to the steps below. 
 

 
 

Diagnostic Screen Item Function 

 File 
Menu selection to Create or Open a diagnostic database.  

This database collects data during a diagnostic run. 

Channel List 

Checkbox listing to enable which chambers to be tested.  

Each channel represents a chamber.  Best practice would be 

to identify each chamber to the corresponding channel.  Ex: 

Channel 1 ➔ Chamber 1 

In Millivolts Value to define the max voltage level on the waveform chart. 

Channel Name Dominate channel selection for the waveform chart. 

Current Signal Avg: Average value (millivolts) of the selected Channel Name. 
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Stimulus... 
Button to open the Cue stimulus window for diagnostic 

purposes. 

Sound Level… 
Button to open a window used to document conversion 

values to decibels. 

SR-LAB Chart Chart to display the current response waveform. 

Response Table Table displaying current response results. 

Remove All button Erases all current entries in the Response Table. 

Samples per Channel 

Number of samples.  NOTE:  Sample rate is fixed at 1 kHz 

therefore number of samples can be inferred to be the length 

of time for the time in milliseconds (X-Axis). 

 

Setting up your SR-LAB for Sound, Response, and Stimulus  
 

Sound Level Diagnostics: 
 
Sound Level Diagnostics is a screen to test analog levels and keep a listing of analog values to decibel 
levels.  Within the dialog is a chart that gives an estimation conversion chart for reference only.  User is 
responsible to verify and record in the “User Lab dB Conversion List” the values determined by 
diagnostic testing.  Once the list has been created it can be referenced in the Trial Definition screen and 
where ever trial definitions are displayed in the program. 
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***Take the Analog Sound Input Level and input 700 in the level box.  Click the Trigger On button to 
make sure the sound is working.  This will be loud.  It will automatically turn off after 1 sec.  If no sound 
comes out of the SR-LAB go back and make sure your cords are attached correctly.  Once confirmed 
sound is present and cords connected correctly more to SR-LAB Calibrating Sound*** 

 
 

Sound Level Item Function 

Analog to dB Conversion Chart 

Example chart demonstration the relationship of Analog 

input to decibel level.  It is the user’s responsibility to 

determine the specific system’s relationship and enter these 

values in the User Lab dB Conversion List. 

User Lab dB Conversion List 

Table to store current lab conversion values from analog 

sound level to actual dB level determined by the Sound 

Calibration procedure. 

Analog Sound Input Slide controls to set the Analog Level and time duration 

On Time 
Time (seconds) for sound to be on.  NOTE:  when slider bar 

is all the way to the right the sound on time is continuous. 

Trigger On 

Button to initiate sound diagnostic test. Once Analog Sound 

Input levels have been set the trigger button will turn on/off 

the Analog sound. 

Repeat Every… Allows for sound to repeat until hitting the Trigger Off 

 

SR-LAB Calibrating Sound 
 
The SR-LAB uses an indirect sound level system due to environmental differences.  The chart displayed 
in the Sound Level Dialog shows the relationship of Analog level (value used in Trial definitions) and dB 
level based on the environment at San Diego Instruments.  This chart should be used as a guideline to 
prepare a listing of Analog levels to be used to create Trial definitions at your location.  The Analog level 
listing will be used to periodically check and calibrate the sound levels of the SR-LAB 

 
Sound Meter Positioning 

Instructions on how to work the Extech meter are included in its packaging.  Make sure that the 
sound meter level is set to “A” scale and FAST mode.  When using the Extech meter, remove the 
enclosure and stand up the sound meter below the speaker inside the SR-LAB cabinet.  Close the 
door completely. You will read the meter through the peep hole in the door.  Do not talk when 
looking through the door as this will affect the meter reading.  Also do not have anybody 
walking around the lab while calibrating sound as this will also affect the reading.   

 

Determining an Analog level for a 120 dB startle pulse 
1. Place meter on, and in the box, with door closed like discussed above. 
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2. Using the chart on the screen, find an Analog level approximately equal to 120 dB (it does not 
have to be exact as you are going to adjust the sound such that the chosen value equals 120 dB).   

3. Enter the chosen value in the level box Sound Level Diagnostic screen.  
4. Slide the On Time arrow all the way right till it shows Continuous On Time 
5. Hit the Trigger On.    
6. Read the meter and if it is not at 120 dB adjust turn the Audio Adjust dial on the test station 

until the meter reads 120 dB. Write down this Analog level in the Lab dB Conversion Chart and 
label it accordingly.   

7. Click on the Trigger off button when finished and move to the next SR-LAB cabinet 
When calibrating multiple boxes it is important to set the Lab dB Conversion Chart on one box.  
Once you have the chart filled out move to the second box.  When you calibrate the additional box 
your dB levels should match ±2.  If it does not use the Audio adjust dial to bring it within range.  Do 
not adjust the Lab dB Conversion Chart to get the correct dB reading. 

 
NOTE: SR-LAB chambers leave San Diego Instruments with a 720 analog level to obtain a 120 dB.  This 
chart is intended to serve only as a general guide.  The actual sound pressure levels produced by the 
Analog command may be substantially different.  It is important to check with a sound level meter for 
each of the noise levels used in a test session.  You can use the Audio adjust dial if need be to calibrate 
the chamber but most of the time it is not necessary to use the Audio adjust.   
 

 

Determining the Analog levels for each of your desired PPI levels and the 
Background level.   
(Note for these sound points the Audio Adjust dial is not used) 
Ambient  

Since Background and PPI levels are set relative to the ambient noise level in the lab this level 
should be determined.  Take a reading of the ambient noise level in your lab and write it down. 

 
Background 

Using the Analog to dB chart in the manual, determine an approximate Analog value for your 
desired dB level for the Background level in the Session definition.  Do the following paragraph. 
 
Enter the chosen value in the text box on the Diagnostic screen. Slide the On Time bar all the way to 
the right so it stays on continuous.  Click trigger and read the dB level on the sound meter. If it is 
either low or high from your desired dB, click on Trigger Off and enter a different Analog level in the 
text box on the Diagnostic screen and hit the Enter key. Read the meter. Repeat the process of 
changing the Analog level until you get the desired dB level. Write down the final analog level. 
 

PPI Levels 
As there are generally several PPI levels the following process will have to be repeated using 
different Analog levels to determine each PPI level. 
 
Using the Analog to dB chart determine an approximate Analog value for the desired dB level for a 
PPI level.  Enter the chosen value in the Level text box.  Slide the On Time bar to the right so it shows 
continuous and hit the Trigger On button.  The sound will turn on and remain on until the Trigger Off 
button is hit.  Read the dB level on the sound meter.  If it is either low or high from your desired dB, 
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repeat the process of changing the Analog level until you get the desired dB level.  Enter Analog 
level for each of your PPI points in the User Lab dB Conversion list and select the Update button to 
save.  This list can be referenced whenever trial definition windows are available. 
 

Conclusion 
Once you have completed the above steps you have developed a sound curve to be used on 
your system.  Publish the Analog levels for each dB level you have determined (Background, 
some number of PPI levels and a Startle pulse level) and let all users know to use these Analog 
levels in their trials.  Periodically check the sound levels to make sure they match your selected 
Analog levels and adjust if necessary.  As the system gets older you may have to develop a new 
sound curve and publish it.   
 

 

Response Standardization 
You want to make sure the response from the animal platform will record when the animal startles.   
To do this go back to the diagnostic main screen →Select channel 1→Click start 
 
Tap your finger on the platform and make sure you see a peak appear on the screen like the below 
screen shot.  This confirms the channels are connected and getting activity. 
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If only testing one chamber move on to Stimulus Diagnostics. 

 

Startle Calibration with the Standardization Unit 
 Only necessary if you have more than 1 SR-LAB  
 
The goal is to provide the same baseline response for each test station using the Standardization Unit 
(vibrator).  The recommended starting values for the AVG reported by the "moto" session is 200 ± 4 for 
adult rat size enclosures (Medium, Large or Extra Large) and 700 ± 14 for mice/juvenile rats size thick 
wall enclosures (Small or Small/Medium).  If using the Ultra-Sensitive thin wall Small or Small/Medium 
enclosure calibrate to 2500 mV.  These values have shown that in most species you will get a good 
startle response.  However, if you find that you have a low/high responding species you may want to 
standardize at a higher level such as 900 +/- 18 or a lower level 150 +/- 3 for example.  The only way to 
determine this is to start with one of our guideline values, run several animals through a startle session 
and review the results.  If you are getting peaks that the software can score then you may want to stay 
with the guideline value.  If you are getting a response with low or no peaks you may want to 
standardize at a higher level.  After standardizing at the new level you will need to re-run some animals 
and check the startle response. 
 
The standardized level can be anything, but once it is determined and set, all animals should be tested at 
the determined standardized level.  There is no way to overload the interface card so you can 
standardize as high as you desire. 
 

Components:  
• Standardization Unit – handle gently! 

• Cable to connect Standardization Unit to power jack mounted in ceiling of 

cabinet (older test stations need to connect to Aux Power jack on side of SR-

LAB Cabinet) 

• Hardware for mounting the calibrator to the animal enclosure plate 

 

Steps 
 

1. Remove the animal enclosure from the base. 

2. Attach the round standardization unit to the animal enclosure by screwing in the 

standardization unit with the screws provided.  Make sure the clear doors on the animal 

enclosure have been removed.  

3. Plug the power cable into the Standardization Unit before plugging it into the power jack.   

4. Put the enclosure and Standardization Unit in the center of the SR-LAB chamber. 
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5.  Plug the power cord into the power jack.  On newer units there is a power jack in the 

ceiling at the front.  On other units the Aux Power jack on the side of the cabinet is used.  If 

using the cable to the Aux Power jack on the side of the test station drape it over the top of 

the cabinet to remove the weight of the cable. 

6. For the most precise standardization, allow the unit to warm up for 15 to 20 minutes 

7. Create or Open a diagnostic database.   

8. Select the chamber(s) you wish to record 

 

9. In the lower left corner, below the list of chambers, you can adjust the height of the Y axis 

to correlate higher or lower depending on your species to be able to see the full wave form. 

 

10. Set the 10-turn Response Adjust nob to gain control on the front of the SR-LAB chamber to 

an initial value of 5.0. 

 
 

11. Select the Start button to begin the calibration process. 

12. Observe the average response value reported on your monitor (for the chamber being 

calibrated). You can see it in the lower right of the screen.  Adjust the 10-turn Response Adjust 

gain control on the front of the chamber for your desired average reading. When the average 

response is stable for 10 trials(recommended), (shows you mVAvg in the chart on the right) 

lock the Response Adjust control.  When the standardization unit is operating within range 

you will see green status indicators.  When the values are not within range the indicators are 

black. 
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The Response Adjust control should not be changed between calibration sessions.   

13. Select the Stop button to end the calibration process. 

14. Proceed to the next chamber and repeat the steps above to standardize it. 

 

Make sure to complete all standardization between chambers as quickly as possible to gain 

accurate readings. The motor inside the standardization unit can over heat causing it to not 

generate a good wave form. 
 

Once all chambers are standardized, take the standardized unit and place back in box and store carefully.  

You will want to standardize frequently to make sure your readings are still accurate. 
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Refer to the following settings for SMALL and SMALL/MEDIUM animal enclosures. 

 

 

 

 

Refer to the following settings for MEDIUM, LARGE, and EXTRA LARGE animal enclosures. 

 

 

 

 

 

 

 

 

 

NOTE: Animals of different sizes may require an increase or decrease in amplification to obtain normal 

data. The user may adjust the response gain (amplification) as high or as low as the dial will allow, to a 

level suitable for their needs, and establish new standardization values based on these.  It is important 

that the calibration value is equal across all SR-LAB cabinets.   
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Stimulus Diagnostics: 
 

 
 

Stimulus Diagnostics Function 

 Stimulus 

Test the digital outputs on the SR-LAB controller.  There is 

a checkbox for each digital output and the trigger button.  

Check the output to test and select the Trigger button.  

When triggered on the LED will turn Cyan when triggered 

off the LED will turn blue.  When triggered on the output 

can be measured using a volt meter. 

Analog To Current Conversion 

Linear graph similar to the White Noise graph.  This 

displays a linear relationship between an Analog level and 

a corresponding Current (mA).  This graph is an estimate 

for information only. 

Shock Level Analog level to use. 

Set Level button 

Button to set the Analog Level.  When the Analog Level 

is set the LED will turn CYAN.  NOTE:  This does not 

necessarily mean that the shocker is outputting the 

corresponding mA.  To get shocker output the Stimulus 

Shock should be checked and the Trigger button pressed. 

Trigger button 

When the check box is checked and Trigger button 

pressed the corresponding digital output will be on.  If 

unchecked the digital output will be off. 

User Lab mA Conversion List 
A notepad table where Analog Level and corresponding 

mA output can be documented.  This table can be 
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referenced in the Trial Definition window as well as other 

windows in the program. 

 
1. Click on the Stimulus button on the bottom of the diagnostic screen 
2. There is a checkbox for each digital output and the trigger button.   
3. Check the output to test and select the Trigger button.  For example, click on the AC RELAY box and 
click trigger.  The overhead light inside the SR-LAB will turn on if connected correctly. 
4. When trigger is ON, the circle will turn Cyan when trigger is OFF the circle will turn blue as shown. 
5.  When triggered ON the output can be measured using a volt meter. 
 
NOTE: Analog Shock Level output range is 0 to 130 which represents a 0 to 5.0 milliamp output 
irrelevant of the 2mA/5mA hardware selector switch on the shocker.  For example, if the selector switch 
is set to 2mA and the analog shock level is 130, the output will still be 5.0 mA. 

 
CHAPTER 4: Setting Up an Experiment 
 

SR-LAB Definition Screens 
 
When the main menu File➔Definitions… is selected there are two definition screens to choose from; 
Trials and Session.  The definitions are saved in a separate definition database so that any study 
database that is created with SR-LAB can access the definition data.   
 
There are also two menu selections to backup and restore the definition files.  This backup will allow 
different users to define specific definitions and store/reload when necessary.  NOTE:  It is necessary to 
back up the definition file before installing an upgraded version of SR-LAB. 
 
The first definition screen to open should be the Trials.   Once a Trial definition has been created and 
saved then the Session definitions should be opened.  Session definitions require Trial definitions. 
 
The flow for setting up an EXPERIMENT is Trials-Session-Create Database. 

 

SR-LAB Trial Definition Screen 
The process of building Trials and building Sessions can be compared to the stringing of beads--the 
individual beads you make are "Trials" and the string and spaces between the beads are the "Sessions." 
A Trial is a discrete test with a stimulus and response recording. A Session is a series of Trials (usually in 
the range of 40 or 50) run on one subject or one group of subjects all stored in a data base. 

 

Defining a Trial 
Creating an SR-LAB Trial definition can be likened to building a timeline. At various points along the 
timeline (or milliseconds in the case of SR-LAB trials) you are telling the SR-LAB software/hardware to 
perform various tasks. The trial definition tells the SR-LAB system what to do at what time. 
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1. Name the trial by clicking on the New Trial button. 
2. Enter in the name or ID you wish to call this trial and click OK.  The name will appear in the Trial 

name box at the top. 
3. Now you will build your trial by selecting the commands one at a time and hitting the Add 

button below to move it over to your List View on the left.  An example would look like this. 

• Example of a Startle Trial using Acoustic Stimuli (sample only) 

• Trial Name: startle 

• At 0 Milliseconds:  Background 

• At 0 Milliseconds:  Sound Level: 725 

• At 0 Milliseconds:  Record Data 

• At 0 Milliseconds:  Wait Length (msec): 20 

• At 20 Milliseconds:  Background 
 

• Example of a Prepulse Startle Trial using Acoustic Stimuli (sample only) 

• Trial Name: ppi 

• At 0 Milliseconds:  Background 

• At 0 Milliseconds:  Sound Level: 475 

• At 0 Milliseconds:  Wait Length (msec): 10 

• At 10 Milliseconds:  Background 
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• At 10 Milliseconds:  Wait Length (msec): 90 

• At 100 Milliseconds: Analog Level: 725 

• At 100 Milliseconds: Record Data 

• At 100 Milliseconds: Wait Length (msec): 20 

• At 120 Milliseconds: Background 
4.  When done creating your Trial select Save Trial.  Repeat steps to create another Trial.  All Trials 

will show in the drop down for Trial Name. 
5. When done creating trials proceed to the Session Definitions. 

 
  

Screen Item Function 

Button New Trial… Button selection to create a new trial name 

 Trial Name 
Drop down list box to select and display any currently 

defined trials 

List View 

Sequential listing of the trial definition.  Listing defines 

sequential index, sequential time when command will 

happen, command and the command parameter 

Standard Commands  

Background 

The sound level is set to the background level identified in 

the “Session Definition” screen.  Background sound is 

default and fixed to a White Noise type. 

Analog 

Command to produce sound.  When Analog is the selected 

item it will be enabled to allow the user to select a millivolt 

level from 0 to 750 mV. 

Level 

Sound level in millivolts (mV).  Sets the amplitude of the 

acoustic stimulus. A table showing the conversion from the 

software units to the resulting decibel level (dB) is included 

on page 21. 

This is enabled when sound is selected.  It also defaults to 

the Analog level of the currently selected Sound ID from the 

drop down list. 

Button Analog To Db List… 

This table is created in the diagnostics window by you to 

show your levels you wish to use.  This button opens a 

dialog where a system specific acoustic level table can be 

viewed.  This table can be referenced throughout the rest of 

the software dialogs where needed.   

Record Data 

Command to start recording response signal.  Data will be 

recorded for the length of time stipulated in the Session 

definition.  NOTE:  each trial definition must contain a 

Record Data command.  This feature is built into the SR-
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LAB software to prevent an inadvertent trial definition that 

contains no provision for the recording of data. 

Wait (msec) 

Sets a wait time before the next command is executed or the 

end of a trial.  The maximum wait length in any one entry is 

60000 milliseconds (1 minute).  If longer wait periods are 

required, several wait commands may be listed in sequence. 

Stimulus Commands 
NOTE:  All stimulus commands are matched with the 

On/Off radio button to define the state of the stimulus. 

Cue out stimulus 

Each Cue out selected controls a +5V ttl output.  Each Cue 

out can be connected to an external cue stimulus.  These 

check boxes must be matched with the Stimulus State 

On/Off radio button.  When On is selected cue will be 

initiated, when Off is selected, cue will be turned off.    

AC Relay (ACR) 
Signal to turn on/off AC Relay output from the control panel 

enabling the use of user defined accessories. 

Shock (S) 

Signal to turn on/off shock signal.  Note:  this triggers the on 

off of the shock ttl signal.  The shock level must be set and 

turned on at least 2 msec before initiating this Shock trigger. 

Digital 1 (DO1) 
Digital output 1.  Will turn on/off +5V ttl output to user 

defined equipment. 

Digital 2 (DO2) 
Digital output 2.  Will turn on/off +5V ttl output to user 

defined equipment. 

Shock Level Commands Parameters used to set a specific shock level current value 

Shock Level 
Value to assign to the shock level desired.  Value is 0 to 130 

inclusive. 

Set Shock Level Check Box to set the current shock level value defined 

Button Analog To mA List… 

This table is created in the diagnostics window by you to 

show your levels you wish to use.  This button opens a 

dialog where a system specific shock level table can be 

viewed.  This table can be referenced throughout the rest of 

the software dialogs where needed.   

Command Buttons 

Command buttons aid with the design and building of a trial 

script.  Once the Commands have been selected use one of 

the Command buttons to build the trial script. 

Add Add the command to the last line of the script 

Insert 

Insert the command into the script.  First select a line in the 

script then select the Insert button.  This will insert the 

command into the script at the selected line and all other 

commands will be moved down.  The “At Time” column 
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will be modified depending on the newly inserted command 

line. 

Edit 

Edit the currently selected command line.  Highlight the 

command line to be edited, make command editions and 

then select the edit button.  The “At Time” column will be 

modified depending on the newly edited command line. 

Delete 

Delete the command line selected.  Highlight the line to be 

deleted and select the Delete button.   The “At Time” 

column will be modified depending on the newly deleted 

command line.  

General Trial Screen Buttons  

Save Trial Saves currently selected Trial to the definition database. 

Save Trial As… 
Saves currently displayed Trial Sequence to a different Trial 

Name. 

Delete Trial 
Removes currently selected Trial from the definition 

database. 

Close 

Closes the SR-LAB Trial Definition window.  If the trial has 

not been saved the program will ask the user if they wish to 

save the current trial. 
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Using Shock Level in a Trial Definition 
 
Shock Level Setting is a mutually exclusive entry for the Trial Definition Sequence.  When the Shock Level 
checkbox is checked the Standard and Stimulus Commands will be unchecked.  Enter the Shock Level 
Analog value, check the Set Shock Level Box and press either the Add, Insert or Edit button to update the 
Trial Definition.   
 
The user can select the Analog To mA List… button to bring up the Shock Conversion Dialog.  If a list was 
created in the Stimulus Dialog window this list will show up here.  The user can highlight a line and when 
the close button is hit the shock level value will be transposed to the Set Dialog number and the 
checkbox will be checked.  This is a convenient and accurate way to maintain the correct Shock 
Level/mA conversion in the Trial Definition Sequence.   
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SR-LAB Session Definition 
 
The purpose of the Session Definition is to continue the process of designing test sessions to run.  The 
session definition defines the Record data window, trials to use, Inter Trial Intervals (ITI), Acclimation 
time and Background Level.  All trials can be review in the Session Definition window. 
 From the main screen select File-Definitions-Sessions to get the screen below 
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Read through the chart below to become familiar with all the options on this screen. 

 
Screen Item Function 

New Session Definition… Button selection to create a new Session ID name. 

Session Definition Drop down list identifying the current session definitions 

Create User Edit box to identify creator of the Session Definition. 

Data Collection Entries 

Data collection entries define the number of samples and 

sampling rate.  Given this data the software will calculate 

the time window for recording of response data.  NOTE: 

Sampling rate is a fixed rate of 1 kHz. 

Acclimation 

Time to wait before starting the trial.  This time allows the 

subject to acclimate to its new surroundings.  Acclimation 

period will be the same for every chamber connected to the 

system. 

Background Level 

Analog level to set the background sound.  Level range is 0 

➔ 750 which relates from 0 to 100% sound level.  By 

default, background sound is white noise only.  This 

background white noise level will be used whenever a 

Background command is encountered in the Trial 

Definition. 

Repetitions 

Number of times to repeat the session run.  Both Trial list 

and the ITI list will run to the end of the list and then cycle 

back to the beginning of the list to complete the number of 

repetitions entered. 

Trial List Parameters  

New Trial List… Button Selection button to create a new trial list 

Trial List ID Drop down box displaying a list of current Trial Lists 

Trial ID’s 
Drop down box displaying a list of trials defined in the SR-

LAB Trial Definition Screen. 

List View A List view of the currently selected Trial List ID. 

Trial List Buttons  

Add Add currently selected Trial ID to the List View 

Insert 

Insert the currently selected Trial ID into the List View.  

Highlight a line in the list view and select the Insert button.  

This will insert the Trial ID into the list at the selected line. 

Remove 

Remove the currently List view line selection from the 

view.  Select the line to remove and click the Remove 

button. 

Trial ID Summary… 
Display the parameters of the currently highlighted Trial ID 

in the list. 

Delete Trial List ID 
This button will delete the Trial List ID from the definition 

database. 

Inter Trial Interview (ITI)  

New ITI… Button to create a new IDI ID 

ITI ID Drop down box to display currently defined ITIs 

List View ITI time listing displaying currently selected ITI ID. 
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Random Number Generator 

Random number generator to create ITI times.  Enter a 

minimum time (seconds), maximum time (seconds), Delta 

(seconds) and quantity.  NOTE: Delta is defined as the 

minimum time difference between two successive entries.  

Quantity is the number of ITI times to generate. 

Save ITI 

Saves ITI to the Session Definition database.  NOTE:  it’s 

necessary to save the ITI separate from saving the session 

definition. 

Delete ITI Deletes ITI from the Session Definition database. 

Save Session Definition  
Saves currently selected Session ID to the Session 

Definition database. 

Delete Session Definition 
Deletes currently selected Session ID from the Session 

Definition database. 

 
1. Click on the New Session Definition to name your definition. 
2. Set your Data Collection options.  You may wish to increase the repetitions. 
3. Click on the new trial list and define the test. 
4. Add your trials in the order you wish for them to test by selecting the drop down Trial IDs, 

selecting your trial and clicking on ADD.  
5. Click on New ITI and name your Inter Trial Interval 
6. Select your order and seconds for the trial OR use the Random Number Generator.  Once 

complete click on Save ITI for future use. 
7. Click Save Session Definition 
8. Click close.  This will take you back to the Main Screen. 
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SR-LAB Session Creation Screen 
 
You will need to create a database by starting on the Main Menu Screen.  Select File-Create new study 
database-and name it.  Make sure to write down where it is saved.   
 
SR-LAB Session Creation screen creates and identifies sessions to be run.  Each session ID will be 
associated with one Session Definition that was created in the SR-LAB Session Definition Screen.  Session 
Definitions can be reviewed in this screen. 
 
Next, select from the Main Menu FILE-Create Sessions to get the screen below 
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1. Click on the Add Session ID and name your session 
2. Check the box from the list of session definitions names for the session definition to use 
3. If you wish to review any session definition check the box and select the Session Def button. 
4. When satisfied with the specific session definition to use with the session click the Save Session 

button and close the window returning you to the Main Menu. 

 
If user wishes to remove a session, select the session ID and select the Remove Session Button.  This will 
permanently remove the session ID from the study database.  
 

Screen Item Function 

Session ID Drop down list of currently identified sessions 

Add Session ID… button Add a new Session ID 

Session ID: Drop down box identifying currently selected Session 

Remove Session 
Button to remove the currently selected Session ID from the 

study database. 

Save Session 
Button to save the currently selected Session ID to the study 

database. 

Session Definition check box list 

A checkbox listing of all defined Session Definitions.  One, 

and only one, session definitions will be selected to be used 

the currently selected Session ID. 

Session Def button Button to display the currently checked session definition 

Close 
Close the Create Session screen.  If the Session has not been 

saved the user will be prompted to save the Session ID 
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SR-LAB Create Subjects Screen 
Main menu-File-Create Subjects 
On this screen, enter the information about the test subjects. The “Chamber” field allows the user to 
enter the chamber where the subjected will be tested.  This value should be chamber 1 to 16 and must 
correlate to the SR-LAB channel being used with the control box. Enter identifying information in the 
Subject, Group and ID fields. When all the information is entered, you have a choice to “Clear”, “Clear 
All”, “Save” or “Close”. If there is a problem with the entered data you can highlight the line and click on 
“Clear” button and start over again.  
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The SR-LAB Session Run Screen:  
 
The Run Startle Session screen (Main Menu-Run-Session) contains information on the trials being run as 
part of the session, a chart of the feedback (in amplitude and milliseconds), the Current Trial State, a 
Start button, Abort Session button, Run and Close buttons and a countdown timer (seconds) for the 
acclimation period and subsequently for the time left before the next trial (inter-trial interval timing). 
There is a checklist of channels (chambers) to use in the session.  The channels must match the channels 
identified with the subject definition.  The screen also contains information on the Session Name, Trial 
Name.  Also, there is a table containing the results of the session run. 

 

 
 
 
 
There are multiple tabs on this screen to assist the user in configuring the session run. 

• Main Run:  main session run window. 

• Signal Graph:   window to display the graphs of the selected channel. 

• Subject List:  window that displays a list view of subjects with their corresponding     
Channel/Timer 
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Countdown Timer:  
During runtime, a countdown to the next trial will be displayed in the lower left part of the display.  
 

Abort Session:  
Clicking on the Abort Session button will immediately end the Session. Data to the point at which the 
Session was aborted will be saved with the filename selected. 

 

Report Screen Item Function 

Main Run Tab Main session run view  

Definition Button 
Button to bring up a read-only window that displays the 

current session and trial definitions.  

Channel List 

A checkbox listing to enable specific channels/chambers to 

use.  NOTE:  These selections must match the 

channels/chambers listed in the Subject List View.  Also 

these channels/chambers must be connected to the SR-LAB 

controller. 

Clock Setting Samples 

Read only box defining the number of data samples to be 

read. Since the Rate is fixed at 1000 Hz Samples can also be 

defined as milliseconds (1 millisecond per sample). 

Clock Setting Rate (Hz) 

Frequency definition.  NOTE: this value is set at 1KHz.  

This value is used so that the number of Samples calculates 

to be the response window time in milliseconds. Ex: 250 

samples at 1000 Hz gives a response window time of 250 

milliseconds. 

Background 
Background level of White Noise sound to be used during 

acclimation and ITI  

Current Trial State Text box displaying current state of the trial 

Response Table Table that collects response results from the trial run. 

 
 

Start Your Session 
Check and make sure your Session ID is correct on the main run tab.   
Click the channels you wish to record data and your subjects labeled on the subject list are correct per 
channel.   
When all the animals are in their chamber, place the enclosures in the center of the SR-LAB unit, close 
the door, and click start and the countdown clock will run showing you when the session will start. 
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Signal Graph Window: 
 
The Signal Graph window contains a single chart of the selected channel.   
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The SR-LAB Report Screen:  

 
The Data Report Screen can be reached by the main menu selection of Run➔Report.  All sessions that 
have completed running their trials can be viewed in the report window. 
 
The full waveform of the response is shown in the graph display. The horizontal axis of the graph auto 
scales to the number of Record Samples contained in the Session Definition. The vertical axis represents 
the amplitude of the response in millivolts. The waveform is automatically scaled to the peak voltage 
recorded.  If a fixed Y-Axis amplitude is desired it can be set by adjusting the Signal (mV) value. 
 
The report window contains the Trial Type name, Trial number, subject name, Group and ID.  There are 
selections to change trials and channels.  Only one waveform can be viewed at a time.  If data have been 
collected on more than one SR-LAB chamber, you can choose the channel to view by clicking in the 
Channel field.  Particular trials that are part of the test session may be selected from the Trial box. The 
purpose of the report window is to view data points recorded at session run time. 
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Report Screen Item Function 

Session ID Select session to view 

Close Button to close the window. 

Trial Info bar 

Trial Info bar is upper bar above the Chart and contains the 

following information: 

Trial Type:      Name of Trial Definition used in trial run 

Trial Number:  Number  of  currently displayed trial 

Subject:            Name of subject in currently displayed trial 

Group:             User supplied subject identifier parameter  

                         Defined at Subject Definition window. 

ID:                   User supplied parameter defined at Subject 

                         Definition window 

Data Info bar Located bottom left of the window 

mV Start 

Voltage at the start of the response window.  This value 

represents the voltage unit recorded in the first millisecond 

of the response window.  It is intended only as a “stability” 

check which can signal that the subject, before having time 

to respond to a startle stimulus, was moving, or making other 

motions that might interfere with the proper recording of a 

startle response.  Thus if this value is high (approaches the 

“Average”) on a Trial, the user may choose not to include 

the Trial’s data in an analysis.  Note that this value, because 

it is based on only a single millisecond will likely be quite 

variable. 

mV Max 
Highest voltage during the response window.  This is the 

“peak” of the response. 

T Max 

Time in milliseconds after the start of the response window 

at which the Time Max response occurred.  This is the 

“latency” to the “peak” of the response.  Note that the time 

recorded, because the response is “rectified”, may be the 

time to either the positive of negative phase of the response 

and latencies and may therefore, be bimodal.  It is 

recommended that this data be carefully examined before 

being reported as averages. 

Average 

The voltage across the entire response window.  The sum of 

the voltages recorded for each millisecond in the Response 

Window divided by the number of milliseconds in the 

Response Window.  NOTE that voltages are reported by the 

software in millivolts. 
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Trial box Allows you to select which trial to view 

Channel Allows you to select which channel to view 

Signal (millivolts) 

This defines the max value for the Y Axis in the waveform 

chart.  Note: when value is 0 the chart Y Axis is variable 

dependent upon the signal response. 

Analog To Db List 

This button opens a dialog where a system specific acoustic 

level table that was recorded when the session trial occurred 

can be viewed.   

Analog To mA List 

This button opens a dialog where a system specific shock 

level table that was recorded when the session trial occurred 

can be viewed.   

  

Copy Chart 
Copies the waveform chart to the windows clipboard.  This 

can then be pasted into any documents.   

Save Chart Saves the waveform chart to a file. 

Export Run Data… 
Button to export the results.  Button opens a dialog to select 

specific sessions and other export parameters. 
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Chapter 5: Analysis Software 
The SR-LAB Analysis:  
 
The SR-LAB Analysis is similar to SR-LAB Report Screen but it is a separate, stand-alone software package 
that allows for independent analysis of the data.  This allows the researcher to take the study database 
and perform analysis on a computer separate from that which is operating the SR-LAB equipment. It also 
allows exporting both raw data and scored data.  Three additional data points can be calculated (scored) 
with this software; The Onset of the first response peak, the amplitude of the first response peak and 
the time (latency) to the first response peak.  NOTE: It is not always the case that the maximum 
amplitude occurs at the first peak.    

 

The SR-LAB SR Parameters:  
 
The Analysis Parameters can be adjusted to determine (score) the Onset of the first response peak, the 
amplitude of the first response peak and the time (latency) to the first response peak. 
 
The algorithm used to define the onset to the first response peak is to first find the peak, which is to 
locate the most consecutive incrementing data points, up to the highest data point that is within the 
Response Window.  That last, highest data point is considered the peak.  Then work back down the 
curve to find the lowest of consecutively decrementing data points that is greater than or equal to the 
calculated baseline average.  Any data points within the baseline window are not considered for an 
onset value. 
 

1. Open SR_Analysis.exe icon on your desk top 
2. File-Open Study Data Base-Select your Data Base 
3. Set your GREEN at the time you wish to start your Analysis 
4. Set your RED at the time you wish to stop your Analysis 
5. Set your Yellow at the base right before the first peak. 
6. Click Score to get your results. 

 
You will see at the bottom of the graph your numbers for that Trial.   
Use the Trial and Channel option on the right of the graph with the arrows to move between all your 
trials and channels to get your results. 
 
See picture below 
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Analysis Parameters Function 

Start Analysis (msec) 

Start time in which to begin analyzing the data.  Start 

Analysis is displayed on the plot as a vertical green line.  If 

Start Analysis is zero (at the beginning of the original plot) 

the green line will not be shown.  Otherwise the Start 

Analysis will show the green line and this will become the 

new 0 point of the plot. 

Analysis Range 

End time (msec) of analysis data.  End Analysis is displayed 

on the plot as a vertical red line.  If End Analysis is the max 

value of the plot the red line will not be shown. 

Baseline 

Window of time (msec) in which to analyze baseline data.  

This window begins at Start Analysis and ends at Start 

Analysis + Baseline. 

Response Window 

The max time (msec) after an onset (before Peak1) for the 

peak detection.  This forces program to ignore a peak 

response that may occur too long after a stimulus to be 

attributed to the stimulus. 

 
The following table describes the functions of the other controls in the Analysis window: 
 

Analysis Window Function 

Session ID Drop down box identifying the current session ID 

Trial Scroll Control 
Scroll window to identify which signal response to display 

in the waveform chart 

Channel Scroll Control 
Scroll window to identify the trial signal response from the 

channel (chamber). 

Signal (millivolts) 

This defines the max value for the Y Axis in the waveform 

chart.  Note: when value is 0 the chart Y Axis is variable 

dependent upon the signal response. 

Trial Info Bar 
Trial info bar contains information for the currently 

displayed trial 

Trial Type Trial Type name as stated in the trial definition 

Trial Number Index number of the displayed trial 

Subject Subject name for current trial 

Group Group name from Subject window 

ID Parameter ID from Subject window 

Scored Data Bar 
Scored data bar displays the results of scoring the currently 

selected trial given the input Analysis Parameters. 
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mV Start Voltage level at start analysis 

mV Max Maximum voltage within analysis range 

T Max Time (msec) at maximum voltage 

mV Avg Average voltage within the analysis range 

mV Baseline Average voltage with the baseline range 

T Onset Time of the onset to Peak 1 

T Peak1 Time of the first peak within the analysis range 

mV Peak1 Voltage level of the first peak within the analysis range 

mV StdDev Standard deviation of the voltage values within the analysis 

range 

Buttons:  

Score 

Start time in which to begin analyzing the data.  Start 

Analysis is displayed on the plot as a vertical green line.  If 

Start Analysis is zero the green line will not be shown. 

Score Session Score Session button will score all trial in the session 

View All Scoring… Button to display a table of all scored trials 

Clear All Scoring Button to clear all scored trials from the view table 

Export Raw Data… 
Button to export the Raw data to Excel or a tab separated 

(*.txt) file.  Data can be exported in row or column format 

Close Close the analysis program 

Chart Buttons:  

Analog Conversion… 

This button opens a dialog where a system specific acoustic 

level table that was recorded when the session trial occurred 

can be viewed.   

Copy Chart… 
Copies the waveform chart to the windows clipboard.  This 

chart can then be pasted into any documents. 

Save Chart… Saves the waveform chart to a file. 
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The SR-LAB Scored Data Window:  
 
The Scored Data Window displays the result of all presently scored trials.  Click on the View All Scoring 
button.  This window provides the opportunity to review the data and also export the viewed data to an 
Excel or a tab separated (.txt) file.  Also, any scored data can be removed by highlighting the line(s) and 
selecting the Remove button.  Data can be sorted on each column in ascending order by clicking on the 
column header. 
 

 
 

Scored Data Window Definition 

Date Date Stamp when data was scored 

Time Time Stamp when data was scored 

Session Session ID 

Subject Subject Name 

Block 
Block number from Trial List defined in the Session 

Definition window 

Group Group information from Subjects window 

ID Parameter information from Subjects window 
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Channel Channel/Chamber Number 

Trial Trial number 

mV Start Voltage (mV) at start of Analysis Chart 

mV Max Maximum Voltage (mV) within range of Analysis Chart 

T Max Time (msec) for mV Max 

Avg Average voltage (mV) for data points within Analysis Chart 

Baseline 

Window of time (msec) in which to analyze baseline data.  

This window begins at Start Analysis and ends at Start 

Analysis + Baseline. 

Onset Time (msec) where signal curve begins to rise to first peak 

T Peak 1 Time (msec) where signal reaches first peak 

mV P1 Voltage (mV) for first Peak 

Error 
Error string if algorithm is unable to locate Onset and first 

peak because of the input parameters. 

E Code Error code defining Error string 

Button Descriptions Definition 

Score Params 
Selection will bring up a window displaying the analysis 

parameters used to score the response(s) 

Remove From List 
Selection will remove all highlighted lines from the scored 

data. 

Export Data 

Selection will export the data to either an Excel or Tab 

separated (*.txt) file.  Data can be exported in either row or 

column format. 

Save To Database 

Selection to save the current scored data to the database.  

When saved the Scored Data Name will be displayed in the 

Current Scored Data dropdown box 

Remove From Database 
Selection will remove the currently identified Scored Data 

from the database. 

Close 
Selection will close the scored data window.  User will be 

asked if they wish to keep the scored data. 
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Chapter 6: SR-LAB Animal Shocker  
SR-LAB Animal Shocker (Potentiated Startle Kit) 
 

The SDI Animal Shocker, or Potentiated Startle Kit, is a multi-function, solid-state unit that 

administers scrambled shock with 8 unique outputs. The unit is designed to provide feedback-

controlled, constant current shock with an output composed of bi-polar, square waves with a 

frequency of 11 Hz (max voltage 250 V). The unique display shows the current levels actually 

being administered to the subject. The display is also used to monitor current levels while in 

the “Adjustment” mode. 
 

The Animal Shocker Current Level can be set in two ways: (1) in ‘manual’ mode where you 

adjust the shock level using the Current Adjust knob on the front of the shocker; or (2) in 

‘program’ mode where the shock level is established in the trial definition.  The shock ON and 

OFF command in the Trial Definition is available in either mode. 

 
SR-LAB Animal Shocker (Potentiated Startle Kit) 

 

Hardware   
The SR-LAB Animal Shocker includes three basic components:  the shocker control unit, the shock grid 
(to be placed in the SR-LAB animal enclosure) and a cue light.  Power to the shocker is applied by 
plugging the power supply into the Aux Power socket on the side of the SR-LAB Test Station. 
 
The power switch is located at the left rear of the shocker control unit.  See the photos below for an 
explanation of the connections required to fully install the SR-LAB Animal Shocker(s). 
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Cue-light 
 
The included cue light is used for light/shock pairing sessions. It is mounted via Velcro to a side wall of 
the chamber in view of the subject.  The wire is passed through the rubber stopper at the rear and 
plugged into the Cue Out jack on the side of the cabinet.  The on/off of the light is controlled by the cue 
command (DO1 or DO2) in the trial definition.  
 

 
 

Installing the Animal Shocker 
 
1.  Set the shocker unit on the top of the SR-LAB Cabinet. 
 
2.  Plug the power cable from the shocker into the Aux. Power jack on the side of the cabinet 
 
3:  Connect the shock trigger cable to the shockers. 
 

 
 
Connect Shock Trigger First Chamber to Remote Operate + on the back of the first shocker.  Run a 
trigger cable from Remote Operate – on the first shocker to Remote Operate + on the second shocker.  
Continue this pattern until you go from Remote Operate – on the last shocker to Shock Trigger Last 
Chamber on the control box. 
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(The Program Input connectors are used with the Potentiated Shock Level Control System.  These 
connectors are currently not active (see setting shock level manually below) 
 
4.  Place the shock grid inside the animal enclosure and run the wire through the rubber stopper on the 
back of the chamber.  Plug the cable into the round Shock Out connector. 
 

Animal Shocker Front Panel Display and Control Knob 
 

The Animal Shocker control unit front panel contains the shock intensity display reading in 

milliamps (mA) with a resolution of 1/100 mA.  The display is active during the adjustment of 

the shock levels using the Adjust switch and when shock is directed to the shock grids.  The 

current Adjust knob sets the shock amplitude when the unit is in manual mode. 
 

 
 

Front Panel Switches 
 

Program/Manual Switch – the position of this switch determines whether the source of the 

shock amplitude is from the setting of the Current Adjust knob (manual) or from a 

programmed 8 bit signal to the Input plug at the rear of the unit.  Note:  For the 

programmable shock, the Potentiated Startle Kit Shock Level Control System must be 

installed. 
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Range Switch – the setting of this switch determines the total range of the shocker output, 0-

5 mA or 0-2 mA.  Note:  In ‘Program” mode only, the 5mA scale is used even if the switch is set 

to 2 mA. 

 

Initiate/External/Adjust – This switch selects the source of the signal that starts the shock. 

"Initiate" starts the shock from the shocker control unit panel. This is a "momentary" switch - 

shock will be sent to the Shock Connector for as long as the switch is held in the up position. 

An "External" switch setting starts the shock when a 4-20 mA current signal is applied at the 

"Remote Operate" plugs in the rear panel. The "Adjust" switch directs the shock to the front 

panel meter. Current will be directed to the meter as long as the switch is in this position.  
 

Front Panel Indicators 
 

There are 3 indicator lamps on the front panel. The lamps illuminate as follows:  

 

• Power - is lighted when there is power to the unit.   

• Shock- is lighted when shock is being delivered at the rear panel’s Shock Out 

connector. 

• Adjust - is lighted when the signal source switch is in the Adjust position. 
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Rear Panel Connections  
 

 
 

Power In - for plugging in the power supply converter 

 
Remote Operate - Connections for remote initiate signal. This signal is provided 

by the Shock ON instruction in the SR-LAB Trial Definition (a 4-20 mA signal).  The Shock OFF 

instruction drops the signal turning off the shock. 

 

Shock Out - Connector for 8 unique, scrambled shock outputs, connected to the SR-LAB 

animal enclosure shock grids. 

 

Program Input for Shock Level Connector (DB-25) 

Note:  This setting is only used with the Potentiated Startle Shock Level Control System. 

 

Input J3 (top) – Connection for expansion of the system by adding additional shockers.  This 

connection links the Control Box to the first shocker or from a previous shocker unit. 

 

Output J4 (bottom) - Connector for 8 bit input for programmed shock amplitude. These are 

signals provided by the Port Command in the SR-LAB Trial Definition. This connection links to 

the next shocker input (J4) for daisy-chaining multiple animal shockers together. 
 

Adjusting Shock Levels  
 

Determine the range of shock desired and set the range switch accordingly (0-2 mA or 0-5 

mA).  NOTE:  The Range switch setting is overridden in the Program Mode to 5 mA. 

 

Manual Mode - Place mode switch in "Manual", set Source switch to "Adjust", then turn 

adjustment knob until desired intensity appears on display. 

 
Program Mode - Future feature.  Currently not implemented. 
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Validating the SR-LAB Animal Shocker Current Level 
 

The information contained in this section explains how to manually check the current level.  

As an alternative to the manual method described below, San Diego Instruments supplies the 

Shock Level Tester (P/N 2325-0224) which automates current level adjustment.  Please 

contact SDI if you are interested in the Shock Level Tester. 

 
To validate the SR-LAB Animal Shocker current level you will need a load resistor. 

 
50 kOhms, an oscilloscope and a differential probe.  Simply take voltage readings (see wave 

shape drawing below) and calculate the instantaneous current with Ohms Law.  This is a 

relatively simple procedure and can be done periodically for the sake of validation.  Follow 

these steps: 

 
WARNING: SHOCK HAZARD IS PRESENT DURING TESTING.  THIS PROCEDURE MUST 

BE PERFORMED ONLY BY TRAINED PERSONNEL. 

 

Steps for Validating the Animal Shocker Current 
 
1. Attach a 50 kOhm resistor (any wattage) across any two-grid bars. 

2. Place the INITIATE switch in the ADJUST position. 

3. Attach the oscilloscope across the load resistor using the differential probe. 

4. Adjust the shock level knob on the SR-LAB until the meter reads the desired level. 
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5. Hold the INITIATE switch in the INITIATE position. 

6. Take a reading of the "Peak" DC voltage displayed on the oscilloscope.  

7. Calculate the current using Ohms Law:  I = E/R.  For example at a 20 V peak with a load of 

50 kOhms, the real time value of the current would be .4 milliamps (mA) 

8.  Compare the Meter reading with the Oscilloscope reading.   

 
The shocker uses polarity switching DC pulses, with phase shifts between grids 

(This is what enables shock between any two grids).  Look at the difference between time B1 

and time B2 on the drawing.  The voltage applied is from a constant current source.  This 

means the circuit will adjust the voltage to the necessary value needed to deliver a specific 

and constant current.  One particular point of interest is that the meter displays the "real 

time" value of the shock, i.e., the meter displays the current at the instant of the pulse.  Duty 

cycle is defined as the percentage of the time the signal is present.   The shocker has a duty 

cycle of approximately 25. 
 

NOTE:  the SCALE switch on the shocker is truly a GAIN switch, i.e., when the switch is 

changed from 2 mA to 5 mA, the output will be increased by a factor of 2.5.  For example, with 

the SCALE on 2 mA and the setting at .2 mA the output will be .2 mA.  The output will increase 

to .5 mA (and will be indicated on the meter) when the SCALE is set to 5 mA.   
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Appendices 
Appendix A: San Diego Instruments Product Warranty 
Appendix B: Troubleshooting & SR-LAB FAQs   
Appendix C: Using Pure Tone Features 
Appendix D: Anxiety Potentiated Startle 
Appendix E:  Tactile Stimulus Kit 
Appendix F: FDA Part 11 Compliance 
Appendix G: Extended Record Time 
Appendix H: Convert Definitions  
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Appendix A: San Diego Instruments Product Warranty  
Products purchased from San Diego Instruments (SDI) are warranted free from defects for a 

period of one year. SDI agrees, for one year from the date of shipment, to replace or repair, at 

SDI’s option, at the SDI factory (9155 Brown Deer Road, Suite 8, San Diego, CA 92121-3248) 

any defective products or components.  San Diego Instruments, at its discretion, reserves the 

right to make repairs and/or replacements at the customer's site. 

 

San Diego Instruments will also provide, for one year from date of shipment, general revisions 

to system software that are appropriate to the client's system. 

 

This Warranty does not cover damage due to misuse, and is void if San Diego Instruments' 

products are subjected to service or modification by anyone other than San Diego Instruments 

or an Authorized Representative. 

 

San Diego Instruments' liability under any Warranty is limited to the original purchase price of 

the system. 

 

Repair or replacement as provided under this warranty is the exclusive remedy of the 

customer.  SDI will not be liable for any incidental or consequential damages for the breach of 

any express or implied warranty on SDI products. Except to the extent prohibited by 

applicable law, any implied warranty of merchantability or fitness for a particular purpose on 

this product is limited to the duration of this warranty. 

 

 

 

 

 

 

Claims for missing components will not be honored beyond 30 days after institution has 

received shipment at loading dock. 

  

NOTE:  Please inspect all shipments for damage upon arrival. If shipping damage are observed, 

contact SDI as soon as possible and RETAIN THE SHIPPING CARTONS for inspection by the 

carrier. Check goods received against the “Expanded Packing List” included with the shipment.  
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Appendix B: Troubleshooting & FAQ’s 
Where does my data get stored? 
Your data will be stored in a data directory named C:\Users\Public\SanDiego Instruments\Data 
 
Where can I find my release code? 
Your release code will be on the inside cover of your quick start manual and on the bottom of your 
control box. 
 
Where do I find my serial number? 
The serial number for San Diego Instruments is a black and gold sticker.  You will find them on the back 
panel of the control box, the back top right corner of the SR-Lab and on each animal enclosure.  If you 
have a standardization unit the black and gold label will be around the barrel of the unit. 
 
Why am I not getting any readings from my SR-LAB? 
The Coaxial cables may be reversed at the IN/OUT connection. Change them on the control box. Verify 
that the units have power (check that light and fan goes on). Check all connections per the manual. 
 
When does the SR-LAB test stop? 
Once the time duration has completed the script will stop and data will be displayed.  Script can also be 
stop by selecting the Stop button. 
 
Why doesn’t my trial work as expected? Why does a stimulus unit stay on after completion of a trial? 
Any commands that terminate after the "Record Window" are ignored. Extend the "Record Window" or 
move the "Record Window" in the Trial. 
Example Trial Definition (assume a 200 msec recording window): 
DO NOT USE THIS TRIAL 
0 msec Background 
0 msec Wait 50 
50 msec Analog 600 
50 msec Record 
50 msec Wait 300 
350 msec Background 
end of Trial 
In the example provided above, the Analog signal will stay on because the Background command at 350 
msec won’t be processed due to the fact that the Record Window went from 50 m to 250 msec. To 
correct this problem, in the Trial Definition, you would change the Wait 300 Command to Wait 200. 
 
For More Information 
Please refer to our website at www.sandiegoinstruments.com, send us an e-mail to 
support@sandiegoinstruments.com or give us a call at 858-530-2600. 

  

http://www.sandiegoinstruments.com/
mailto:support@sandiegoinstruments.com
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Appendix C: Using Pure Tone Features  
 
Set up 
The Pure Tone system utilizes an external function generator and audio amplifier to deliver tones.  The 
speaker used for the Pure Tone is an external isodynamic tweeter which is mounted in the top of the SR 
Lab cabinet.  The tone is generated by applying an analog voltage level to the function generator which 
outputs the corresponding sine wave frequency to the audio amplifier for output. 
 

• Connect a BNC cable to the Pure Tone Connection on the rear of the SR_LAB control box in 

Figure 1.    

• Connect the other end of the BNC cable to the VCG INPUT (left) of the BK PRECISION function 

generator shown in Figure 2. 

 

Figure 1 

 
 

Figure 2 

 
 
 

• Connect a separate BNC cable from the BK PRECISION function generator OUTPUT to the RCA 

splitter cable.  Connect the RCA splitter cable to the CD ports, located bottom left of the 

amplifier back panel. Use supplied BNC to RCA splitter. See Figure 3 and Figure 4 
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If you have more then four (4) speakers a second amplifier will be sent with your order.  

You will need to attach an included T adaptor to the OUTPUT channel on the function 

generator and connect two BNC cables to each RCA splitter cable on the respected 

amplifier. 

 

Figure 3 

 

 

Figure 4 

 

• Most amplifiers have an “A” “B” and “A + B” mode.  Make sure dial on front is set to A+B.  This 

allows a total of four (4) speakers to be run off one amplifier. 
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• Connect the speakers to the four available connections.  Note polarity when connecting 

speakers so that text on wire is always connected to positive.  Turn screw adjust open, thread 

exposed wire into opening and screw down to tighten.  Continue until all speakers are 

connected.  Reference Figure 6 

 

 
Figure 5 

 

 

Figure 5 
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Figure 6 

• Mount the included speaker to the desired location inside the cabinet using the adhesive 

backing of the speaker. 

 

Overview: 
 
SR-LAB can be used in conjunction with a function generator to produce a specific sine wave frequency 
tone which be used when assessing frequency discrimination in mice and/or rats.    

 
Setting Control Box and Driver Software: 
 
The SR-LAB control box consists of 16 Analog input channels on the front panel, 1 Analog output to 
produce white noise sound, 1 Analog output to produce a shock level, 1 Analog output to produce the 
Pure Tone frequency level as well as 4 digital (ttl) outputs on the rear panel.  These are dedicated 
outputs so when using the control box for Pure Tone use the appropriately labeled output on the 
control box. 
 
Before connecting the USB from the control box to the computer install the MCC DAQ Software.  Once 
the MCC drivers have been installed plug in the SRLAB MCC controller (USB).  

1) Run from the start button Start➔All Programs➔Measurement Computing➔ let the system 

recognize the board.  It will go through some questions that you answer yes to so it can 

recognize the board. 
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2) Once the board is recognized Board#0 - USB-2527 (serial#.........).   Double click on it to bring up 

the Board Configuration dialog: 

a. Change No. of Channels: to  16 Single Ended (This will allow 16 input channels to be 

used) 

b. Change Settling Time: 10us (this will prevent ADC input channel crosstalk) 

 

 
 

Configure software for Pure Tone testing: 
 
San Diego Instruments will provide a release code number to unlock the pure tone feature.  To enable 
Pure Tone run the SR-LAB software and from the menu select Run➔Release Key…  This will open a 
dialog to enter the code number provided. 
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This key should be kept in a safe place in case software is reinstalled or updated.  Once the release code 
has been entered the SR-LAB software should be restarted. 
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SR_LAB Pure Tone Diagnostics: 
 

The SDI SR-LAB software can be used with Pure Tone to diagnose and setup the Pure Tone feature.  
From the main menu select Run➔Diagnostics…  This will bring up the Sound Level Diagnostics screen 
which will have a Pure Tone… button located above the Analog Sound Input group box.  
 

   
 
Select the Pure Tone… button to bring up the Pure Tone Calibration/Diagnostics window. 
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In this window there are instructions for calibrating and setting up pure tone frequencies.   The best 

default is to set the function generator range set to 50k and output to sine (∿).   

 
The purpose of the calibration group box is to enter min/max values so the software can create a 
linear relationship to determine an estimated voltage level for a specific output frequency.  
 
From the Calibration group box: 

1. In the “Max Frequency (Hz) box enter a value to represent a maximum frequency.  With function 
generator set to 50K 40,000 is a good entry.  In the “Volts for 0 Hz” box enter 0 and use the 
adjustment knobs on the function generator to set the output to 40K. 
 

2. Once these values have been synced enter an estimated voltage (0 – 10V) and select Trigger.  
Adjust the “Volts for 0 Hz” until the readout on the function generator is 0.00. 
 

From The Diagnostics group box: 
1. Enter a desired frequency and hit the Trigger button.  The algorithm will determine a voltage 

based on the calibration values.  This will show the frequency readout on the function 
generator. 
 

2. From there adjust the up/down voltage readout to get to the desired frequency.  Once desired 
frequency has been reached select the “Add To Table” button to record the Level/Frequency 
correlation. 
 

From the Table: 
When added to the table the Name cell is filled with a default name.  This name can be edited by double 
clicking the mouse on the Name cell.   
 
The frequency can be output by double clicking on the table row.  This will enter the values in the 
Diagnostics group box and trigger the output. 
 
Highlighting the row and right clicking the mouse will bring up a context menu to edit or delete the row. 
 
Selecting the Save button will save current table data for use in the Trial/Session definition windows.  
Only frequencies in this table will be available in the definition windows.  The voltage level determined 
from step 2 from the Calibration group box will set the frequency to 0 Hz, essentially turning off the pure 
tone.  This line is required in the table so it will be automatically generated and saved when the save 
button is selected. 
 
 
NOTE: 

When using the voltage output from the SR_LAB Controller to the BK Function Generator there is a slight 

variability of the PT tone output therefore SDI recommends a best practice of running the PT 

Diagnostics/Calibration before running a test session.  
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SR_LAB Pure Tone Trial Definition: 
 
The frequencies defined in the Pure Tone diagnostics window are available to use in the Trial Definition 
window and is located in the Standard Commands group box.  Use the dropdown box to select the 
frequency to use and check the Set PT Level box.  Select the Add, Insert, Edit button to enter the 
frequency in the trial sequence definition. 
 

 
 
 
In this particular example the Background is defined in the Session Definition window and can be either 
a white noise or pure tone level.  Also, since the Analog (white noise) and frequency are separate 
outputs it is not necessary to explicitly turn off one while turning on the other.  The runtime algorithm 
determines that these two entries are mutually exclusive so when one channel is “on” the other channel 
will be “off”.  If the trial designer determines that there should be moments of silence during the trial 
then the Analog 0 and Frequency 0 can be used to turn off the outputs. 
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SR_LAB Pure Tone Session Definition: 
 
The frequencies defined in the Pure Tone diagnostics window are available to use in the Session 
Definition Window.  Either a white noise level or a pure tone frequency can be selected but, again, this 
selection is mutually exclusive. 
 

               
 
 
To select a pure tone background, select a frequency from the dropdown box and check the Set Pure 
Tone level.  This will hide the white noise background and set its value to 0 volts. 
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Appendix D: Anxiety Potentiated Startle 
 
Anxiety Potentiated Startle tests the animal in an anxious state and a relaxed state and 

compares the results.  The anxious state is induced via the High Intensity Light Bar, which is 

affixed to the side wall of the chamber via 3M strips.  You can select either a red or white light 

bar for your assay. The wire is passed through the rubber stopper at the rear and connected 

to the Cue Out connector on the back of the chamber.  The Cue command controls the on/off 

state of the High Intensity Light Bar. 

 

 
 

Note:  On the white light the tabs of 3M Command® strips which are pulled down to remove the light 

bar. 
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Appendix E:  Tactile Stimulus Kit  
 

 
 
The Tactile kit allows for a more humane stimulus then the fear potentiated startle kit.   
 

1. First connect the plug attached to the black solenoid box to the Cue Out connector to the back 
of each Startle test station. 

2. Second, attach the yellow tubing to the animal enclosure with the included thumb screws 
3. Third, thread the yellow tubing out the back stopper of the Startle test station. 
4. Connect the yellow tubing to the AIR OUT side of the manifold. Turn the white nut to tighten the 

grip on the yellow tubing.  Be sure to not over tighten as it can pinch the yellow tubing cutting 
off the air. 

5. Do the same with the additional yellow tubing to the AIR IN and connect the other end to your 
air source. 

6. The CUE command controls the on/off of the air puff for each trial. 
 
 
Your air source can be any compressed air tank or centralized laboratory air (non-flammable).  Best 
option is to obtain a tank of nitrogen as it is both dry and non-flammable.  When selecting your air 
source please consider the volume of air you will need, specifically, the desired psi, duration of air-
puff, number of presentations, etc.   
 
***the maximum operating air pressure input of the Tactile Unit is 60psi.  The air source must be 
REGULATED*** 
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Appendix F: FDA Part 11 Compliance  
This appendix applies to users that are submitting their research to any regulatory agencies. If the user 
has not purchased the SR-LAB FDA Part 11 Compliance software package this appendix is not applicable.  
 
Unique User ID 
The program administrator assigns each user a unique User ID.  The User ID can be any combination of 
letters and numbers and is case sensitive.  It is the responsibility of the administration to determine the 
appropriateness of a User ID.  No limits are set by the program for length of User ID or number of users 
on the user list. 
 
Secret Password 
The program administrator assigns a password when a new User ID is added to the user list.  There are 
no limits set by the program for the password assigned by the administrator.  The user should change 
the password the first time they log on to the program.  The password is case sensitive.  After the user 
has changed the password, it is their secret.  Not even the administrator can learn the secret password. 
 
Multiple Levels of Access 
The levels available are Administrator, Supervisor, Auditor and User. 
 
Administrator 

✓ Assigns initial User ID 
✓ Inputs SR-Lab Release Code 
✓ Assigns or changes privilege level 
✓ View/Creates activity reports 
✓ Creates user list 

 
Supervisor 

✓ Reviews and export data 
✓ Create/Edit a study DB file 
✓ View/Creates activity reports 
✓ Defines a Trials, Sessions 
✓ Creates Subjects, Sessions 
✓ Run Options,  Diagnostics 
 

Auditor 
✓ Reviews data edits 
✓ Reviews summary reports 
✓ View/Creates activity reports 

 
User 

✓ Run a session 
✓ Run Diagnostics 



SR-Lab Installation & Operation Manual 

80 
6310-0000-S 
 

Automatic Password Expiration 
Passwords expire automatically in 30, 60, 90, 365 days.  The Administrator password does not expire.  If 
a password expires, the administrator must assign a new User ID to reactivate the user.  A selection can 
be made so the password will not expire. 
 
Failed Log on Attempts 
The user may make three attempts to enter a valid ID password combination.  If the password ID 
combination attempt fails the predetermined number of times, the program becomes unusable (until a 
valid login is entered).   
 
Encrypted User List 
The user list is authenticated, encrypted and stored as an encrypted file.  The file cannot be edited using 
normal methods.  An ASCII text file of the user list can be generated by the Administrator on demand.  
The administrator may also view a list of users on the monitor screen.  The password information is 
omitted from both of these lists. 
 
Encrypted Activity Log 
All significant actions are logged to an encrypted activity log file.  The activity log contains: 

✓ Time, date User timestamp 
✓ Activity (Login, Logout, add user, change password, modify data) 
✓ User name associated with activity 
✓ User authority level (administrator, supervisor, auditor, user) 
✓ Current database connection 
 

The purpose of the special features incorporated in this version of the SR-LAB Software is to limit and 
control access to the SR-LAB data and definition files. 
 
A valid User ID and password are required to begin the program.  After starting the program, the user 
should go to the main menu and select Run➔Login… then enter an ID and password.  The program 
verifies the existence of an authority file.  If the user fails to log in, the program displays an error 
message and does not continue.  
 
If the log attempt is successful the program compares the ID and password to the User List.  If there is a 
match, the program then checks that the password has not expired.  An expired password terminates the 
program.  An error message is displayed to contact the administrator.  If the date is valid, the program 
begins with authorities allowed the particular user.  The user may make three attempts to enter a valid ID 
password combination. The program denies access if the password ID combination is attempted and fails 
three times. 
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Files 
Activity Log 

Logout 
• Login/Logoff Success / Failure 

• Adding/Removing a USER ID 

• Expiring a USER ID 

• Changing a password 

• Creating a study Database file 

• File Connect/Disconnect 

• Modifying a study Database file 
 
The activity log file is encrypted and is not viewable or editable using normal methods. The administrator 
may make a tab delimited text copy of the file as needed.  Activity is also logged to an open database 
during the time that database is open.  Both the encrypted and database activity log can be viewed in the 
SR_LAB Activity window, if the database is open.  There is a button available that will toggle between the 
two views.  This database activity log can also be viewed directly in the database however, it cannot be 
modified. 
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User List (authority file) 

The user list contains: 
• USER ID (assigned by the administrator) 

• User password (chosen by the user) 

• User authority level 

• Active days remaining for USER 
 
The user list file is encrypted and is not viewable or editable using normal methods. The administrator 
may make a copy of the user list that does not contain passwords. 
 

Using the FDA Part 11 Software  
After a successful software installation the default login UserID is “Admin” and password is “admin”.  
The administrator, once logged in, should go to the Run➔Administrator screen and add a new 
administrator with a unique UserID and password for the administrator level.  The USER ID Admin 
should not be deactivated (Removed) until the administrator has logged on with the new ID and 
password.  To change the password, the user must “Change Password…” from the Run menu.  This will 
bring a “Change Password” dialog where the new password will be entered.  The procedures for 
assigning USER ID and PASSWORD are explained in the next section. 
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Change Password Utility 
Once a password has been assigned to a new user this new user should log in with that password and 
change it to a unique password that only the new user will know.  A record of this password should be 
kept in a safe place since this password, if lost or forgotten, is not retrievable, even by the administrator. 
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Administrator Utility 
The administrator can add and removed users from the Run➔Administrator screen.    The administrator 
also assigns authority level and life span of the user.  A list of the current users is also available in this 
screen.  This list includes the User ID, authority level and remaining until user/password expires.  The 
User ID must be unique in respect to the current user list.  The Default Log Directory is identified in this 
window.  This is the directory location of all files relating to FDA_P11 such as Authority.enc Activity.enc 
and all report files. 
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Data Editing 
Only a user with the authority level of Supervisor may edit the original subject data.  The Supervisor 
selects from the current list of subjects in the current session and, after selecting the Edit… button a 
dialog will appear with fields that can be edited.  If multiple selections of the list are made, the subject 
ID must be the same for all lines selected.  Once the subject data has been edited the current list will 
show the new current subject data and the edit data history list will record the changes with a 
timestamp and the activity will be updated (with timestamp) identifying a “Subject Edit” activity. 
 
The subject edit data history can be exported to a tab separated file which can be viewed in Excel. 
 

Reports 
All report files are tab separated text files that can be view and printed with Excel or any notepad type 
program.  Report files are stored in the directory identified in the Administrator… screen. 
Files created are: 
 
Authority_UserList.txt   
Activity_List.txt   
Xxx_SSS_EditSubject.txt NOTE: xxx indicates the name of the study database and SSS is                                  

the session ID. 

 

Creating SR-LAB Working Directories on Shared Network 
 
With the standard installation of SR-LAB software there are three default data directories 

created: 

 
Data Directory: Directory where study databases are located. 
   Located at C:\Users\Public\San Diego Instruments\SR_LAB\Data 
 
Definition Directory: Dir where the definition database (SRDB_Definition.mdb) is located.  
   Located at: C:\ProgramData\San Diego Instruments\SRLAB\Definition 
 
FDAP11 Directory: Dir where the FDAP11 files are located.  
   Located at: C:\ProgramData\San Diego Instruments\SRLAB\FDAP11   
The SR-LAB software can be installed on multiple computers to aid with research where one computer 
can define the trials and sessions (at office) and a second computer can run the actual sessions in the 
lab.  The two computers must be connected to a LAN and commonly shared directories should be used 
as the default SR-LAB directories.  
Steps to creating SR-LAB default working directories on a shared network directory: 
 

1) Install SR-LAB software on two or more computers. 

 

2) Run SR-LAB from computer 1. 
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3) From Main menu:  Run➔Login to Log in to the software using default Admin/admin 

ID/password. 

 

4) From Main menu: Run➔Administrator…  The Default Log Directory is “C:\ProgramData\San 

Diego Instruments\SRLAB\FDAP11”.  Select the Browse… to navigate to the new shared 

directory location.  NOTE:  If a new folder is made the folder should be renamed and hit the 

Enter key before selecting the OK button. 

 

5) To Define the Default Data Directory: 

a. NOTE: user will have to be logged in with Supervisor authority. 

b.  From Menu run:  File➔Define Default Data Directory…  

c. In the dialog browse to the new default data directory.  NOTE:  If a new folder is made 

the folder should be renamed and hit the Enter key before selecting the OK button. 

 

6) To define the Default Definition Directory: 

a. NOTE: user will have to be logged in with Supervisor authority. 

b. From Menu run: File➔Definitions…➔Define Default Definition Directory… 

c. In the dialog browse to the new default definition directory.  .  NOTE:  If a new folder is 

made the folder should be renamed and hit the Enter key before selecting the OK 

button.   

d. If there is not a file in the new directory the current definition file will be copied to the 

new default definition directory.  Otherwise the user will be asked if they wish to 

overwrite the default definition file. 

e. A backup subdirectory will also be created. 

7) Run SR-LAB from computer 2 and repeat steps 3 thru 6.  NOTE:  The first time this procedure is 
run the necessary files are copied to the new directory.  Running this procedure on following 
computers will ask the user if they wish to overwrite the current files.  

 
NOTE: When using SR-Lab with this configuration it’s important that SR-Lab is running exclusively on 
only one computer.  SR-Lab software cannot determine if the same database file is being used by 
another instance of the program and this can cause database issues.  
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Appendix G: Extended Record Time  
 

The normal Maximum Record Time for SRLAB is 10 seconds (10,000 msec).  SDI provides a 
feature to extend the Maximum Record Time to 30 minutes (1,800,000 msec).  This feature can 
allow for delayed reactions to stimulus to still be recorded. 
There are some considerations when using this option: 

1) When the Maximum Record Time is set beyond 10 seconds the response waveform will 

not be displayed in the Report Dialog.  To visualize a response plot the data must be 

exported to Excel or some other statistical or data software. 

 

2) If Max Record Time is greater than 17 minutes the waveform data cannot be exported 

to Excel because of Excel’s maximum row limitation.  The waveform data will be 

exported as a tab separated (“.txt”) file.  From that point the data can be divided into 

smaller excel files or exported to other statistical programs. 

 

3) Though the extended record time is set for 30 minutes all timing parameters are in 

milliseconds.  The sample rate for SRLAB is 1 kHz so, for example, one minute is equal to 

60 seconds * 1000 ➔ 60,000 milliseconds. 

 

To Increase Maximum Record Time from the main dialog main menu select 
Run➔Options➔Extend Record Time….   Selecting the Ctrl key plus the F1 key simultaneously 
will also bring up the Show Report Chart dialog. 
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When the Show Report Chart checkbox is checked the maximum record data time is 10 seconds 
(10,000 msec).  When this checkbox is unchecked there is an additional parameter that allows 
the user to extend to the time from 1 minute to 30 minutes with a one minute resolution. 
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This is an example of a trial definition using extended record time.  This trial example starts 
recording data at time 0 and then the ACR is turned on at time five minutes. Then, five minutes 
later (time at 10 minutes) turned off.  All Stimuli can be incorporated in an extended time trial 
definition including Background, Analog and all Cue Out Stimuli. 
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This session definition describes a record time of 15 minutes using the previously defined 
extendedTimeTrial Trial Definition: 
 

 
 
When a session is created using this definition the session trial will run, recording data for a 
period of 15 minutes.  At the five minute mark the ACR will be turned on and at ten minutes the 
ACR will be turned off.  Recording of the response data will continue until the 15 minute 
(900000 msec) has been reached. 
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In the Report Dialog an extended time session will not display the response data.  To get the 
response data select the Export Run Data… button.  
 

 
 
Because of a maximum time of 30 minutes and the default data sampling rate of 1 kHz the 
export file is fixed as a tab separated file (*.txt extension).  The purpose for this is that Excel has 
a maximum row specification of 1,048,576 (220) rows.  For an extended time of 17 minutes or 
less a single Excel file can be used.  For any time exceeding 17 minutes it will be necessary to 
take the tab separated file and partially parse it to separate excel files.  Check for any row or 
data limitations with other third party data files. 
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Appendix H: Convert Definitions  
 
Before USB version of SRLAB trial and session definitions were encoded to *.TAS ans *.SAS files.  
Beginning with SRLAB software # 6300-0000-U these files can be converted to the newer trial 
and session definition formats.  To do this select File➔Definitions…➔Convert Definitions…  
This will bring up an Open File Dialog Box.  Navigate to the location of the *.TAS and *.SAS files.  
Multiple files can be selected to convert. 
 

  

 
The conversion algorithm first decrypts the files to a *.txt file then parses that file to create new 
trial and session definitions which is then loaded into the definition database.  NOTE: “PCI Port” 
commands are now obsolete and will not be converted as well as the “End of Trial” command 
which is no longer necessary.  The “Tactile” command will be converted to “AC Relay” (ACR) in 
the converted Trial definition. 
 

 
 
Text files can be viewed and printed by selecting the View Text Files… button. 
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It is the user’s responsibility to validate that all trial definitions have been converted.  For 
example in the Sessions definition window it is important that all defined trials in the Trial List 
have actually been converted. To do these highlight the trial in the list and select the Trial ID 
Summary… button.  If the trial summary comes up then the trial has been converted. If not 
(blank screen) the trial has not been converted and should either be converted or removed 
from the list. 
 

 

 
It is also the user’s responsibility to verify that analog levels are producing the required Decibel 
level required. 
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If the following error occurs: 
 

 
 
The file has already been converted and should be in the Trial or Session definitions screens. 
 


